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Starting the Scheduler  
 
To start the SCHEDULER GUI application, do one of the following: 
 
1) From the Programs Menu (under the Start button), select the program Service 

Order Scheduler from the submenu of the same name. 
 

 
 
 
2) Create a shortcut and place it on the Desktop. Locate the file SOS.EXE on your system 

(it will default to location /SOS/SYSTEM/) and press the right mouse button and select 
Create Shortcut. Drag and drop the newly created shortcut to the Desktop. You can 
also create shortcuts for the Calendar (SOSCAL.EXE) and the Pending Lists 
(SOSPEND.EXE) windows. Once created, you can start the SCHEDULER by double 
clicking on the shortcut. 
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Service Order Scheduler Window 
 
The Service Order Scheduler window should now appear. If this is the first time you are 
running the program, some setup information may be requested from you. See Scheduler 
GUI Setup for a review of those screens.  
 
 
 
   The service order currently available to be scheduled. This value can be set from 
   a service order path on the attached AS/400, or from the calendar path. 
 
File Menu        Menu Bar 

       
Connection Name used to  
communicate with AS/400 application. 
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File Menu and Menu Bar 
 
 

 

 Set Library List – Updates the AS/400 library list used by the scheduling 
window.  
 

 Refresh Display (F5) – Reloads information on the screen from the most recently 
saved copy of the schedule. 
 

 Reload Service Techs – Updates the local file that contains Service Tech 
information. This option will automatically run if the local file (sossvtech.txt) is not 
found or is empty (see Scheduler GUI Setup). 
 

 Reacquire IP Address – If the IP address does not appear in the lower right 
corner of the display, then this program will not be able to communicate directly with the 
CIS system running on the Server. Select this option to tell the program to attempt to 
retrieve the IP address again. 
 

 Calendar – Starts the SCHEDULER’S calendar window. 
 

 Pending Schedule Lists – Starts the SCHEDULER’S work lists for Unscheduled 
Orders and Rescheduled Orders. 
 

 Exit – Exits the SCHEDULER and closes any windows opened while in the 
SCHEDULER. 
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Service Order Schedule Information 
 
Current Schedule – This represents the existing schedule date and time for the selected 
service order, or “No Schedule Found” if the order has not yet been scheduled. If the 
existing schedule is followed by “* expired *”, the service order is still open, but the 
schedule date has passed. 
 
Service Tech (drop-down list) – Provides a list of available Service Techs that can been 
assigned to this order for completion. This list is only available if the Override to Tech 
box has been checked. 
 
Override to Tech – If checked, this tells the SCHEDULER to assign the Service Tech named 
in the drop-down list to this order. 
 

 Date Search – Press this button to display a calendar that can be used to select the 
Start Date in the Use Schedule Overrides section. (see Date Search in the SOS Calendar 
section for details of how this window works). 
 
Use Schedule Overrides – If checked, allows the user to override the following 
scheduling parameters: 
 

• Start (month, day, year, hour, min) – Defines the point in time where the 
SCHEDULER will begin looking for the first available schedule date.  
 

• End (month, day, year, hour, min) – Defines the point in time where the 
SCHEDULER will stop looking for an available schedule date. 

 
• From and To Time Window – Defines the window of time that can be searched 

for an available schedule date. Only times within this window are looked at by the 
SCHEDULER for each day between the Start and End dates. 

 
• Priority Scheduling – If checked, the service order is given the first available 

time, whether or not that time is already scheduled to another (non-priority) order. 
 
• Check After Hours – If checked, this flag tells the SCHEDULER to include time 

intervals marked as “after hours” when searching for the first available schedule 
date. If the Priority Scheduling box is checked, this box is automatically selected 
and cannot be overridden. 

 
• Scheduling Method – Allows the user to override the default method of 

scheduling. Only one of the methods can be selected. If the Priority Scheduling 
box is checked, the Issue Set Time method is automatically selected and cannot be 
overridden. 
! Select Date Only – Service order is scheduled to a specific date only. 
! Appointment Window – Service order is scheduled to a specific date and time 

period (AM/PM). 
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! Issue Set Time – Service order is scheduled to a specific date and time of day. 
 
Selected Service Tech – This is the Service Tech picked by the SCHEDULER to complete the 
service order. 
 
Selected Schedule Date/Time – This is the next available schedule date (and time) as 
returned by the SCHEDULER. 
 
Next Available Button – Use this to cycle through the available schedule dates within the 
selected time period.  Note:  You can only move forward through the available times. To 
restart the search, Refresh the screen or change the Start date. 
 
Apply Button – Press this button to assign the next available schedule date and time to the 
service order. In most cases, this will be the same date and time shown in the Selected 
Schedule Date/Time field, but it may be different. This would occur if the date and time is 
no longer available (was selected for another service order by another user). 
 
 
Service Order Schedule Log 
 
Displays a chronological listing of scheduling events for this service order. 
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Scheduler Trace Info 
 
Displays the output from the Scheduler trace. 
 

 
 
Note: this tab will only display if the user has been granted update authority to the 
SOS_TRACE option in the GUI security file. 
 

 

 
Toggle the trace on and off  Retrieve Next Available\ 
    date and time. 
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SOS Calendar 
 
From the Scheduling window or Pending Schedule Lists window, press the Calendar 
button on the Menu Bar or select the Calendar item from the File Menu. 
 
 
 
Previous Day 
  Service Tech ID button can be pressed to show    Date Search 
  their scheduling limits for the selected date.    Next Day 
 

   
                  Connection ID 
 
The date that appears directly below the menu bar controls which schedule is being 
displayed. 
 

 Press the Previous Day button to move the calendar back one day. 
 

 Press the Next Day button to move the calendar ahead one day. 
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 Use the Date Search to jump directly to a calendar in the past or in the future. 
 
 

Current selected month and year. User can 
 select another date from these combo boxes. 
 

 
  

Previous Month  Next Month 
 
       End Date Search 
 
 
Tabs – Through the use of filters you can display up to 10 different calendar windows. 
Use these tabs to jump to the desired calendar. 
 
Leftmost Column – The time of day appears in the leftmost column of the calendar 
detail.  
 
Remaining Columns – The Service Tech code and name appear in a button at the top of 
each column. You can press this button to display a window that allows update of the 
Service Tech’s scheduling limits. 
 
Scheduled service orders appear below the Service Tech they are assigned to. The color 
used to display the order indicates the scheduling method used for the order. 
 
 Red  =  Priority schedule 
 Green =  Issued set date and time 
 White  =  Assigned to date and time period (AM/PM) 
 Yellow  =  Assigned to date only 
 Blue = Completed orders 
 

The current selected date will appear 
as a raised button. 
 
Holidays (as indicated in the CIS file 
UHOL) will appear with a red border. 
If you place the mouse pointer over a 
date marked as a holiday, a description 
will appear. 
 
A single or double click on one of the 
calendar dates will close this window 
and load the SCHEDULER calendar with 
entries from the selected date. 
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Calendar “Pop-up” Menu 
 

 
 
Pressing the right mouse button while the mouse 
pointer is within the Calendar detail portion of the 
window will bring up an edit menu with up to four 
options. 
 
 
 

 
• Display S/O Info – This will display a window containing more information about 

the service order. 

 
  
• Update Schedule – This will call the Scheduling window and allows you to change 

an existing schedule entry (this option is also called if the user double-clicks on one 
of the scheduled entries in the list). This menu item only appears if the mouse pointer 
is over an existing scheduled service order. 

 
• Delete Schedule – This allows you to delete an existing schedule entry in the 

calendar. You will be prompted to confirm the delete request, and any deleted 
schedules are logged in the Schedule Log file. This menu item only appears if the 
mouse pointer is over an existing scheduled service order. 

 
• Print Schedule – This will enable you to print a listing of all scheduled orders for 

this Service Tech on this date. Note:  The printout is sent to the AS/400 for printing, 
and the output queue is referenced in the completion message. 
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• Reschedule – This will allow you to move currently scheduled orders from one 

Service Tech to other available Service Techs. 
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File Menu and Menu Bar 
 

 

 Set Library List – Updates the AS/400 library list used by the scheduling 
window.  
 

 Refresh (F5) - Reloads information on the screen from the most recently saved 
copy of the schedule. 
 

 Reload Service Techs – Updates the local file that contains Service Tech 
information. This option will automatically run if the local file (sossvtech.txt) is not 
found or is empty (see Scheduler GUI Setup). 
 

 Reacquire IP Address – If the IP address does not appear in the lower right 
corner of the display, then this program will not be able to communicate directly with the 
CIS system running on the Server. Select this option to tell the program to attempt to 
retrieve the IP address again. 
 

 Update Svc Tech Limits – Displays a drop-down list box that can be used to 
select any Service Tech for updating their scheduling limits for the day.  (See the Update 
Svc Tech Limits section for more details.) 
 

 Update Territories – Displays a hierarchical list of available service territories 
and the Service Techs assigned to those territories. From this window you can change 



 

   
Page 12  Service Order Scheduler by InsightAtlast   
  GUI Quick Reference Guide; December 11, 2001 
  Proprietary and Confidential 

various scheduling parameters for one or more Service Techs. (See the Update by 
Territory section for more details.) 
 
 

 Auto Refresh On – If set to on (✓ ), the window will automatically refresh itself 
every 30 seconds.  
 

 Filter On/Off – If set to on (✓ ), the Calendar will only show Service Techs that 
match the filter criteria. 
 
 

User Preferences – Display a window that allows the user to set how the Calendar 
will display. Can be used to limit the service tech schedules included in the list. 

From the submenu, you can set the filter on (✓ ) or off, and you can change the filter 
settings. (See the Update Preferences section for more details.) 
 

 Scheduling Window – Starts the Scheduling window. 
 

 Pending Schedule Lists – Starts the SCHEDULER’S work lists for Unscheduled 
Orders and Rescheduled Orders. 
 

 
SOSPalm Interface – Starts the SOSPalm interface program used to transfer 
Scheduling data to and from a Palm Pilot.  

 

 Exit – Exits the Calendar and closes any windows opened by the Calendar. 
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Update Svc Tech Limits 
 
This drop-down list displays when you select the Update Svc Tech Limits item from the 
File Menu or the Menu Bar. 
 

 
Once you select a Service Tech from the available list, the Service Tech Limits window 
is displayed. If there are no Service Techs in the list, exit from this window and run the 
Reload Service Techs option. 
 
Update by Territory 
 
This window, which is displayed when you select the Update Territories item from the 
File Menu or Menu Bar, is used to apply changes to the scheduling limits for one or more 
Service Techs. 

 
The left side of the window (as seen on 
left) displays a hierarchical view of the 
territories and Service Techs available 
for this date. Select any entry from this 
list and the update portion of the 
window, pictured below, will be 
available for data entry. 
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The right side of the “Update 
by Territory” window (as 
seen on left) is used to enter 
the changes that you want to 
apply to all selected Service 
Techs. 
 
Average Travel Time, Buffer 
Time, Future Minutes, 
Priority Minutes, and Total 
Minutes are all incremented 
(or decremented) by a 
number of minutes. 
 
Daily Limit and Time 
Interval are incremented (or 
decremented) by a count. 
 
After Hours is only available 
if you increment the Total 
Minutes field, and is used to 

assign any newly created time intervals as “after hours”. 
 
Block out time (from/to) is entered as military time, where the from time must be less 
than or equal to the to time. Once this has been applied, the specified time block is 
removed from all selected Service Techs. 
 
This appears at the bottom of the “Update by Territory” Window. 

 
Refresh Button – Press to reload the Territories list. 
 
Cancel Button – Press to exit from the window (any pending changes are lost). 
 
Apply Button – Press to apply the scheduling limit changes to all selected Service Techs. 
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Update Preferences 
 
This window is displayed when you click the User Preferences button on the Menu Bar 
or select the option of the same name on the File Menu. 
 

The Preferences tab allows the 
user to control certain aspects of 
the Calendar behavior. 
 
Auto Refersh On - Toggles the 
on/off setting for the automatic 
refresh time.  
 
Auto Refresh Interval – The 
number of seconds of inactivity 
before the automatic refresh 
begins. Valid range: 30-600 
seconds; default = 30. 
 
Calendar Starting Position – 
indicates the time entry that will 
appear at the top of the window 
when the Calendar is loaded or 
refreshed. 

 
 Current Time – The current system time. 
 First Schedule – The time of the first scheduled order for the day. 
 None – The first available time of the day (midnight). 
 
Column Width – The width, in pixels, of each Service Tech’s schedule column. The 
smaller the number, the more columns will display in the window. Valid range: 100-200 
pixels; default = 135. 
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This window is displayed when you click the Filters tab on the User Preferences window. 
 
 

Filter On – Toggles the on/off setting 
for the selection filters (this is the same 
as selecting the Filter On item from the 
Filters submenu). 
 
Tabs – You can specify up to 10 
different selection filters that will 
provide you with an equal number of 
Calendar windows when filtering is 
active. 
 
Filter Values – Enter the values that 
will determine which Service Techs are 
selected for display. The Filter Label is 
displayed on the tabs on the Calendar 
window. Partial values are acceptable 
for the selection criteria (in the above 
example, all Service Techs scheduled 
for this day whose district begins with 
“POR” will be selected for the 
Calendar that appears under the first 
tab).  

 
Note:  Only those fields that are used to define your Service Territory appear on this 
window. 
 



   
Service Order Scheduler by InsightAtlast  Page 17 
GUI Quick Reference Guide; December 11, 2001 
Proprietary and Confidential   

Service Tech Limits 
 

 
You can access this window by pressing one of the column heading buttons on the 
Calendar Screen that contains a Service Tech ID, or by bringing up the “Update Svc Tech 
Limits” drop-down list and selecting a Service Tech. Use the slider bars to increase or 
decrease the limit for the Service Tech in any of the three categories. 
 
Note:  Moving one slider bar will increase or decrease the other two slider bars. It is 
possible to have the number of minutes used in any column exceed the limits for the day, 
especially if the limits were reduced after orders have been scheduled to this Service 
Tech. 
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Statistics 
 
Maximum number of  available for this Tech – This is the total number of minutes that 
the Service Tech has available based on their work schedule defined in the Scheduler 
control files. For instance, if a Service Tech has a work schedule defined as 8:15 – 11:30 
AM, and 12:30 – 4:15 PM, then the maximum number of minutes that they can be 
scheduled for as any one time is 420. 
 
Total number of minutes allowed for Non-Priority Orders – This is the value specified in 
the Scheduler Daily Limits control file for Non-Pty Orders. This number cannot 
exceed the “Maximum number of minutes available for this Tech”.  
 
Additional minutes reserved strictly for Priority Orders – This is the value specified in 
the Scheduler Daily Limits control file, and is the difference between Priority Minutes 
and Non-Pty Minutes. This number cannot exceed the “Maximum number of minutes 
available for this Tech”.  
 
Total minutes currently allowed for this Tech – This is the value specified in the 
Scheduler Daily Limits control file for Priority Minutes. This number cannot exceed 
the “Maximum number of minutes available for this Tech”. 
 
Number of minutes remaining in the work day – This value represents the number of 
minutes that the Service Tech has remaining in their work schedule for the day, and is 
used to adjust the available minutes that they can be scheduled.  
 
Note: this value only appears when displaying the limits for a Service Tech on the current system 
date and the number of minutes remaining in the work day is less than the “Total minutes 
currently allowed for this Tech”. 
 
Pending (“Open”) minutes – the number of minutes of Priority and Non-Priority orders 
that are still open for this Service Tech. These minutes count against the total number of 
minutes that a Service Tech can be scheduled on a particular date. 
 
Completed (“Closed”) minutes – the number of minutes of Priority and Non-Priority 
orders that have already been completed by this Service Tech. These minutes can be 
“reclaimed” by the Scheduler and used for scheduling additional orders to this Tech. This 
allows the Scheduler to give additional orders to your fastest Service Techs. 
 
Available for Scheduling – the number of minutes that can be scheduled for this Tech. 
These values are adjusted by the number of pending orders and the remaining minutes in 
the work day. The number that appears in red to the right of the Priority minutes available 
is the number of minutes that can be scheduled for Priority work before Non-Priority 
orders would need to be rescheduled. 
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Minutes Used 
This graph is used to indicate the number of minutes already scheduled to this Service 
Tech and the number of minutes remaining to be scheduled on this date. 
 
• Priority – the number of priority minutes scheduled for this Service Tech. 
• Non-Priority – the number of non-priority minutes scheduled to this Service Tech. 
• Remaining – the number of minutes left to be scheduled to this Service Tech. 
• Overage – the number of minutes over Current Limit for the Service Tech that could 

be used if desired (equal to the  
 
 
Refresh Button – This button will update the window with the most recent values from 
the Scheduler database. 
 
Reset Button – This will reset the slider bar settings to their original state (their value 
when the window was first displayed). 
 
Cancel Button – Closes the Limits window and returns to the Calendar. Pressing this 
button has no effect on the value of the slider bars, since any changes are updated 
immediately. If you do not want to apply changes that you have made while in this 
window, press the Reset button prior to pressing Cancel. 
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Additional Statistics 
 
If you would like to view additional statistical information related to the Service Tech’s 
availability to be scheduled, press the right mouse button from within the white statistics 
box on the limits window. The following window will display: 
 

 
This window contains a breakdown of the different types of scheduled orders for the 
Service Tech, as well as the details of how the remaining minutes are calculated for both 
Non-Priority and Priority orders. 
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Reschedule Window 
 
This window appears when the Reschedule menu item is selected from the Calendar 
detail edit menu (right mouse button). 
 

 
  Press this button when you are ready 
  to reschedule the orders. 
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Pending Schedule Lists Window 
 
From the Scheduling window or Calendar window, select the Pending Schedule Lists 
item from the File Menu or the Menu Bar. 
 

Count of selected service orders 
 

           
IP Address 

 
 

Unscheduled Service Orders 
You can display up to 200 unscheduled service orders at one time. This list includes open 
service orders that have never been scheduled (service order number is black) as well as 
orders whose existing schedule date has passed (service order number is blue). 
 
Rescheduled Service Orders 
You can display up to 100 Rescheduled Service Orders at one time. This list includes 
orders whose existing schedule was changed by the system to a different date or time, 
most likely as a result of being “bumped” by a priority-scheduling event. 
 
Double clicking on an entry in these lists brings up the Scheduling Window for the 
selected Service Order. 
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Service Order Information 
 
You can access this window by pressing the right mouse button while the mouse pointer 
is over an item in the Unscheduled or Rescheduled Service Orders lists. 

 
  Reschedule Information   “Acknowledge” button 
      
 
This window is virtually the same regardless of whether you select it from the 
Unscheduled or the Rescheduled list. The only difference is that the Reschedule 
Information box does not appear when the window is displayed from the Unscheduled 
list, and the Service Order Comments section is enlarged to cover that area. 
 
If the user presses the “Acknowledge” button for a rescheduled order, they are 
confirming that they have reviewed the new schedule information and that the new 
schedule date and time is acceptable. Once an order has been “acknowledged”, it is 
removed from the Rescheduled list. 
 



 

   
Page 24  Service Order Scheduler by InsightAtlast   
  GUI Quick Reference Guide; December 11, 2001 
  Proprietary and Confidential 

 
File Menu and Menu Bar 
 

 

 Set Library List – Updates the AS/400 library list used by the scheduling 
window.  
 

 Refresh (F5) - Reloads information on the screen from the most recently saved 
copy of the schedule. 
 

 Reacquire IP Address – If the IP address does not appear in the lower right 
corner of the display, then this program will not be able to communicate directly with the 
CIS system running on the Server. Select this option to tell the program to attempt to 
retrieve the IP address again. 
 

 Auto Refresh On – If set to on (✓ ), the window will automatically refresh itself 
at an interval set by the user (default is 30 seconds).  
 

 Filter On – If set to on (✓ ), it can be used to limit the orders included in the list. 
The filter values are set from the Preferences menu.  
 

 Preferences – Use this option to tailor how the Pending Lists display. (See the 
Preferences section for more details.) 
 
 

 Scheduling Window – Starts the SCHEDULER’S scheduling window. 
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 Calendar – Starts the SCHEDULER’S Calendar window. 
 

 Exit – Exits the Pending Lists window and closes any windows opened by it. 
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Preferences 
 
Maximum Records to Retrieve – 
Allows you to limit the number of 
records retrieved from the database. 
This number should be as small as is 
practical to optimize the 
performance of loading the lists. 
Note:  The maximum number of 
records for Unscheduled Orders is 
200. 
 
Sort Sequence – Controls the 
sequence that the records are 
displayed based on the service order 
number. 
 
Auto Refresh Interval – Controls 
the interval that the system will 
automatically refresh the lists (if 
Auto Refresh is On).  

 
Display this page first – Check this box if you want the Unscheduled Orders list to 
display when the program initiates. If there are no unscheduled orders to display, and 
there are rescheduled orders, then the Rescheduled Orders list will display first. 
 

 
Maximum Records to Retrieve – 
allows you to limit the number of 
records retrieved from the database. 
This number should be as small as is 
practical to optimize the 
performance of loading the lists. 
Note: The maximum number of 
records for Rescheduled Orders is 
100. 
 
Sort Sequence – Controls the 
sequence that the records are 
displayed based on the service order 
number. 
 
Display this page first – Check this 
box if you want the Rescheduled 
Orders list to display when the 
program initiates. If there are no 

rescheduled orders to display, and there are unscheduled orders, then the Unscheduled 
Orders list will display first. 
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Filter On – Toggles the on/off 
setting for the selection filters (this 
is the same as selecting the Filter 
On item from the Filters submenu). 
 
Filter Values – Enter the value(s) 
that you want to filter the list 
selection by. Partial values are 
acceptable (in the above example, 
all unscheduled orders for this day 
whose district beginning with 
“SAL” will be selected). Note:  
Some entry fields may be 
unavailable (indicated by a gray 
entry box) because those fields are 
not used by the Scheduler to 
determine a Service Tech’s 
territory. 
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Scheduler GUI Setup 

 
 
Installation instructions: Refer to the file named README.TXT that was included on 
the product CD. 
 
Each time that the application is initiated, it will check that all the information that it 
needs to operate is available. If the information is not found, a series of windows will 
appear to prompt you through loading the information into the system. Normally, these 
are set up when you initially install the software, and do not need to be set up again. 
 
A. “sos.rst”  file not found – This file is essential to the application and to the VARPG 

runtime module, and must exist in order for the application to run. If this file is not 
found, or it is empty, a window with setup options will appear. 

 

 
 

If this is the first time that the Scheduler has been installed on this PC, you will need 
to define certain parameters for the VARPG Run-time module. Use the “Define 
TCP/IP Server” option to direct SOS to the desired AS/400. The “Define Server 
Logon” option allows you to establish a default sign-on to the AS/400 when you 
initiate the Scheduler. If you do not define a server logon here, you will be prompted 
for an AS/400 sign-on id and password each time you start SOS. 
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The “Define AS/400 Information” option allows you to directly modify the Remote 
Server Tables (.rst) files for any of the components of the Scheduler. Using this 
option can be cumbersome, and it is recommended that you use this only if you 
experienced at setting up a VARPG environment. 
 
The “Set IP Address for SOS” option connects the Scheduler application to the 
desired AS/400. 

 
Enter the name of the server (i.e.: “Production AS/400”, etc.), the IP Address of the 
server, and press the Apply button to update the Remote Server Tables for the 
application. 
 
Once all this information has been loaded, the program will issue a message that the 
application needs to be restarted in order for the changes to take effect. 

  
B. AS/400 library list not found – The application requires that a library list be 

established on the AS/400. There are four libraries that are required in order to run the 
application: a) SCHEDULER program library; b) application files library, c) CIS 
application library (may be the same as #1, and if so, can be omitted here); and d) CIS 
common objects library (normally something like OCLIB or OCSUP). 
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C. Service Tech file not found – For performance considerations, a local file is created 

that contains Service Tech ID and Name. If the file is not found, the system will load 
it for you prior to initiating the scheduling window. 

 
 

 
 
Note:  You can cancel this load process by pressing the Stop button, but you will have an 
incomplete list of Service Techs available to the application. You can reload this 
information at any time by selecting the Reload Service Tech item from the File Menu. 
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SOS CD Installation Instructions 
 
Standard Windows Install 
 
If this is the first time you are installing any VARPG product on this computer, you must 
first install the VARPG runtime. If you know that the runtime is already installed on this 
computer, proceed to section 2. If you are unsure if the VARPG runtime has been 
installed, go to the Start Menu on the Windows Task Bar, and select the Programs 
Option. Look for a menu selection entitled: “VisualAge for RPG – Run-Time”. If you see 
this option, you can proceed to section 2. 
 
1) Installing the VARPG Run-Time. 
 

a) Insert the CD labeled SOS V1.3 into the CD-ROM drive on your computer. 
b) If “autorun” is enabled on your PC, then the SOS GUI installation screen will 

automatically appear. Cancel out of this window as you do not want to install this 
product yet. 

c) Using Windows Explorer or My Computer, select the CD-ROM drive. 
d) Select the folder entitled “VARPG – Runtime”, and double-click on the file 

“Setup.exe”. 
e) Select the default setting by pressing the Next button several times until you reach 

the final screen where you will press the Finish button. 
f) Once the run-time has been installed, you will be asked to Restart Windows. 

Answer Yes to this prompt. 
g) After the computer reboots, you can proceed to section 3. 

 
2) If you already have a version of the SOS GUI installed on the computer: 
 

a) Select My Computer on your desktop. 
b) Select Control Panel, and then Add/Remove Programs. 
c) Select the item titled “NNG – Service Order Scheduler”, and press the 

Add/Remove button. 
d) Click the Yes button to the prompt that asks, “Are you sure you would like to 

Uninstall product NNG –Service Order Scheduler”. 
e) After uninstalling the product, you will be asked to Restart Windows. Answer 

Yes. 
f) Once the PC reboots, proceed to the first product installation step in section 3. 

 
3) Product Installation. 
 

a) Insert the CD labeled SOS V1.3 into the CD-ROM drive on your computer. 
b) If the computer is configured to allow “autorun”, the Installation screen will 

automatically appear. If the install screen does not appear, then press the Start 
button on the Windows Task Bar, and select the Run option. Enter “x:/Setup.exe”, 
where x: is equal to the CD drive on your computer. Press the OK button. 

c) From the installation screen, press the Next button until you reach the last 
window, where you will press the Finish button. 
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d) Once the product has been installed, you will be asked if you want to add a 
shortcut to the desktop for the VARPG runtime. Answer No to this prompt. 

e) Finally, a confirmation screen will appear to indicate that the installation is 
complete. 
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LAN Install 
 
Installing the Scheduler GUI on a Local Area Network (LAN) enables all of your users to 
access one version of the application, making it easier to roll out new versions and fixes 
to all of the client PC’s at one time. In addition to installing the application on a LAN 
drive, you must also install VARPG “pointers” to both the VARPG runtime and 
application modules on each client PC. These pointers are installed using the Compact 
option from the application install process. 
 
Installing the Scheduler GUI on the Network drive x: 
 
1. Create a directory on the Network drive x: called VARPG Install. 
 
2. Copy from CD or Extract from the zip file the VARPG Runtime Installation programs 

to the “x:\VARPG Install\VARPG Runtime” folder. (To download the latest version of 
the VARPG Runtime, visit the downloads page for Service Order Scheduler at 
www.insightatlast.com.) 

 
3. Copy from CD or Extract from the zip file the NWN SOS GUI programs to the 

“x:\VARPG Install\SOS” folder. (To download the latest version of the NWN SOS 
GUI, visit the downloads page for Service Order Scheduler at www.insightatlast.com.) 

 
4. Install the VARPG Runtime on the Network drive by running the x:\VARPG 

Install\VARPG Runtime\Setup.exe command. From the second install panel, change 
the DESTINATION DIRECTORY to be x:\vrpgrt_lan. 

 
5. Accept the other default installation values by pressing the Next button on all the 

remaining panels. When prompted, answer Yes to Restart your system. 
 
6. Install the SOS GUI application on the Network drive by running the x:\VARPG 

Install\SOS\Setup.exe command. From the second install panel, change the 
DESTINATION DIRECTORY to be x:\sos_lan. 

 
7. Accept the other default installation values by pressing the Next button on all the 

remaining panels. When prompted, answer No to Add shortcut to desktop for VARPG 
Runtime. 

 
Installing the Scheduler GUI on the client PC’s: 
 
1. Make sure the client PC is mapped to the Network drive containing the VARPG 

Runtime and SOS GUI applications. 
 
2. Run the command Setup.exe in the x:\VARPG Install\VARPG Runtime directory. 

From the second install panel, change the INSTALLATION TYPE to be Compact.  
 
 
3. Accept the other default installation values by pressing the Next button on all the 

remaining panels. When prompted, answer Yes to Restart your system. 

http://www.insightatlast.com/
http://www.insightatlast.com/
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4. Run the command Setup.exe in the x:\VARPG Install\SOS directory. From the second 

install panel, change the INSTALLATION TYPE to be Compact. 
 
5. Accept the other default installation values by pressing the Next button on all the 

remaining panels. When prompted, answer No to Add shortcut to desktop for VARPG 
Runtime. 

 
6. You can initiate the Scheduler GUI from the Windows Programs Menu, or you can 

add a Shortcut to the desktop of the client PC. If you choose to add a Shortcut, create 
it so that the target directory is x:\SOS_LAN\SYSTEM\SOS.EXE, but the Start In 
value is c:\SOS\SYSTEM. 

 
7. Repeat this process for each client PC. 
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